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Overview

The Professional Analyst, Flight Path Shadow Graph Edition software can provide
accurate 3-D measurements of points and angles using simultaneously acquired images
from apair of cameras. This document describes the application interface, the calibration
and measurement procedure, and the data export capabilities of the software.

For more information on the technical background of this software and a discussion of

the accuracy and sources of error, please refer to the Professional Analyst, Flight Path
Shadow Graph Edition, Brief Technical Overview document.
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Application

The application has three main document types: Calibration, Measurement, and Event
Summary. The Calibration document uses images of a calibration fixture taken by a pair
of cameras and computes a calibration for each camera. The resulting calibration pair is
used by the Measurement document to do precise measurements on a pair of images from
an event. A sequence of Measurement documents is used to construct an Event Summary
document that compares the results from each of the Measurement documents to produce
asummary of the event. Each of these document types will be explained in more detail

in the later sections.

User Acquired Images (BMP, JPEG, TIFF)

Checkerboard Image

(for each lens)

Callibration Fixture

Image Pair

Measurement

Image Pair(s)

y

Lens Distortion
Computation

Lens Distortion Correction

Lens Distortion Correction (optional)

Callibration

Measurement

Event Summary

Coordinates, Angles

Export Results (Text, Excel)

Coordinates, Angles,

Velocities

In addition to the Calibration and Measurement images, an optional Lens Distortion

Correction tool is provided for removing radial lens distortion from images. If distortion
IS present in your lenses, then images of a checkerboard target should be taken using each
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lens and the resulting lens distortion correction computed. See the Appendix for more
details on Lens Distortion Correction.

Application Windows

The main application window has three primary sections: the main desktop area where
documents appear, the Graph windows, typically docked on the right, and the Points List,
typically docked on the bottom.

§

Ak T awl s

The Graphs dialog contains a set of 3D graphs and a set of 2D graphs. The 3D graph can
be rotated by clicking and dragging the left mouse button. To pan the 3D and 2D graphs,
hold the Shift key while clicking and dragging the left mouse button. To zoom the 3D
and 2D graphs, hold the Alt key while clicking and dragging the left mouse button. If
your mouse is equipped with awheel button, the wheel can also be used to zoom the
graph windows. Additional options are available in the context menu by clicking the
right mouse button over the graphs.
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The Points List provides information about all selected points for the Calibration and
M easurement Documents and it provides information about the Measurement Line Pairs
for the Event Summary Documents.

Document windows typically have controls on the right and images on the left. The
images can be panned and zoomed using the same controls as the graphs. Shift + left
mouse button for panning, and Alt + left mouse button for zooming. The mouse wheel
also controls zooming. When using the mouse wheel to zoom, the image will zoom
infout on the currently selected point. This allows the user to very quickly zoom in and
out on a particular feature. Click where you would like to zoom, then use the mouse
wheel. The application will automatically center the current selected point.

Document windows will have a toolbar across the top of each window. The document
toolbar typically contains some or all of the following controls. Many of the items below
have separate settings for the top and bottom views. Click on the view that you wish to
change the settings for and then click on the desired toolbar button. A green box in the
upper right corner of each view indicates which view is currently active.

Bl Toggle Side Panel
Switch the side panel between a small toolbar version and the full size
version.

& Image Settings
Adjust image settings such as brightness, contrast, gamma, etc.. This
control has separate settings for the top and bottom views.

B L ocate Point Settings
Adjust parameters for the automatic location of points for Calibration
Documents. This feature will be discussed later in this document. This
control has separate settings for the top and bottom views.

A% Define World Reference Frame
Define the transformation to the world reference frame for Calibration
Documents. This feature will be discussed later in this document.

B Define Reference Markers
Define location of reference markers. These markers are used to perform
approximate compensation for small camera motions.

= Enable Midpoint Finder
Enable the midpoint finder tool. Thistool alows you to click and drag
two endpoints of alinein the image. The program will draw a marker that
indicates the center of the line. The program will also draw acircle
through the two endpoints and centered on the center of theline. To hide
the midpoint finder tool, click anywhere in the image, but do not drag.

Enable Reticle
Show or hide the reticle (cross-hairs) in the view. This control has
separate settings for the top and bottom views.

B Enable Rulers
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Show or hide rulers along the edges of the view. This control has separate
settings for the top and bottom views.

*1 Show Point Labels
Show point labels (numbers) next to each point in the view. This control
has separate settings for the top and bottom views.

¢ Flip Vertical
Flip the image vertically. This control has separate settings for the top and
bottom views.

“* Fip Horizontal
Flip the image horizontally. This control has separate settings for the top
and bottom views.

11 View Actual Size
Resize the displayed image so that it is shown at the actual resolution of
theimage. This control has separate settings for the top and bottom view.
Ed Fit in Window
Resi ze the displayed image so that the complete image is shown in the
view. Thiscontrol has separate settings for the top and bottom view.

*+ Pan Mode
Set the mouse mode to pan mode so that all left click and drag mouse
operations will pan theimage. This control has separate settings for the
top and bottom views.

+* Zoom Mode
Set the mouse mode to zoom mode so that all left click and drag mouse
operations will zoom the image. This control has separate settings for the
top and bottom views.

Typical Test Scenario

A typical test scenario has multiple steps. The first step is camera calibration. During
calibration, you prepare the cameras to be able to perform precise measurements by
determining properties of the cameras. Thisistypically done by capturing images of a
calibration fixture and then analyzing these images to produce a calibration file. The next
step isto run the actual projectile tests to conduct measurements. During measurement,
images of the projectile are captured by the calibrated cameras. These measurement
images, combined with the calibration from the cameras, are then used to produce 3D
measurements of points on the projectile.

The calibration step only needs to be performed as necessary. If none of the cameras

have been moved or changed since the last calibration, then the previous calibration
should be satisfactory. The uncertainty in the measurements can be used to determineif a
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new calibration isrequired. If the uncertainty exceeds a desired limit, then a new
calibration must be performed.

If there are multiple camera stations located along the firing path, then calibration and
measurement must be performed for each station. The measurements from each of the
camera stations are then combined to produce an event summary. An event summary isa
collection of measurements from multiple camera stations for asingle firing event. The
event summary computes additional information by comparing the results from each of
the measurements, such as velocity and angular velocity.

Calibration

In order to perform accurate measurements using the camera system, a calibration must
first be performed. This calibration computes necessary information about the properties
and location of each camera. If any of the cameras are moved or changed after
calibration, then a new calibration must be performed.

Cdlibration is performed by capturing images of special calibration fixtures that have
fiducial markers at precisely known locations. These images can then be analyzed and
the properties of the camera systems can be determined.

If your test setup has multiple stations, aworld reference frame must be defined in order
to compare results from one station to another. Multiple techniques for defining aworld
reference frame are discussed in alater section of this document.

The recommended technique is to ensure alignment of multiple calibration fixtures using
adjustableirises. A typical calibration procedure for an event with multiple stations:

1. Anoptical alignment device (e.g. alaser or theodolite) should be used to ensure
alignment of each calibration fixture relative to the firing path. Place the
alignment device next to the gun barrel and shine it down the expected path of the
projectile.

2. Placethe calibration fixture in the center of the field of view of each camera,
roughly aligned to the path of the projectile (within £6-7mm). The entire
calibration fixture (including irises) should be completely visible in both camera
views.

3. Adjust the position of the irises on the ends of the calibration fixture using the
fine adjustment screws so that the laser passes through the exact center of both
irises when they are closed. If the alignment device cannot be centered on the
irises, then shift the whole calibration fixture so that the aignment device can be
centered in the irises.

4. Measure the distance from the gun barrel to the first iris on each calibration
fixture. Thiswill be the Z Coordinate of the First Point for each fixture. This
value is used to help define the world reference frame.
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5. Measure the angle of each calibration fixture in the direction perpendicular to the
path of the projectile. Thiswill be the Base Angle for each fixture. Thisvaueis

used to help define the world reference frame.

6. Captureimages of each calibration fixture from each camera.

An example of the alignment of multiple fixture designs using alaser is shown below.
Y our fixtures may not appear like the ones shown below, however, they must have some
common elements, such as the adjustable irises that are visible by both cameras in each

station.

The resulting images are then used to create Calibration Documents for each camera pair.

A Calibration Document is created by selecting File > New.

x
Calibration |
| b eazurement I

Event Summarny |

Cancel i

Then select Calibration. An empty calibration document will appear.
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Calibration :: Untitled Calibration 10| x|
BB P~ BE A~ 1E |+ L

— Load Images

Load First Image I

Load Second Image |

 Lens Distortion and Fisture —

Ho image loaded. Lens 1 | I - Mone -
Lens 2 | Im
Fistuire | I - MNone -
— Paintz

" Manual % Automatic

Define First Begion |

[efine Second Reagion |

Locate Align |

— Calibrate

Calibrate

Ho image loaded. Wiew Calibration

Set Az Default

I
|
Save Calibration |
I

[ Graph Camera Locations
[™ ‘wodd Beference Frame

All controls are located on the top toolbar and on the left panel of the Calibration
Document window. The toolbar controls were described earlier in this document.

The standard procedure for calibrating camerasiis as follows:

1. Load thefirst calibration image by clicking on the L oad First I mage button and
select the correct image file (BMP, TIFF, or JPEG). Thisimage should be from
the left camera when looking down the flight path towards the target.

2. Load the second calibration image by clicking on the L oad Second I mage button
and select the correct image file. Thisimage should be from the right camera
when looking down the flight path towards the target.

3. If thelensesthat are being used require distortion correction, load the appropriate
lens coefficient files using the L ens 1 button or the L ens 2 button for the first and
second images respectively. The lens coefficient files (*.lens) should be
generated using the Lens Distortion Correction Tool described in the Appendix.

4. Load the fixture information file for the specific calibration fixture that is being
used. The fixture file (*.fixt) should have been generated from theodolite
measurements. The fixture file contains information about the location of the
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fixture points and the default units of measure. The method for generating a
fixture file from theodolite measurements is discussed in the next section.

5. Now the fixture points need to be identified in the top and bottom images. There
are multiple options for locating the fixture points. It can be done manually or
automatically.

To locate points automatically:

Select Automatic in the Points section of the right panel.

Define aregion around all the fixture points in the top image by clicking
on Define First Region. Then click the left mouse button at the four
corners of the polygon containing all the fixture points. Make sure that
you include all fixture points. If you make a mistake, click on Define
First Region again and redraw the region.

Define aregion around all the fixture points in the bottom image by
clicking on Define Second Region. Then click the left mouse button at
the four corners of the polygon containing all the fixture pointsin the
bottom image.

Click on L ocate to automatically locate fixture points in both images.

Calibration :: Untitled Calibration 10| x|
ESELE ~ BE* 40 ME| &+ o

— Load Images

Load First Image |

Load Second Image |

 Lens Distortion and Fisture —

Lens 1 | I ~Mone -
Lom2| [ Fore -
Fisture | IW
 Paints

" Manual % Automatic

Define First Begion |

| [efine Second Reagion I

Locate | Align |

— Calibrate

Calibrate

Save Calibration

Set Az Default

I
Wiew Calibration |
I
I

[ Graph Camera Locations
[™ ‘wodd Beference Frame
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If the automatic location of points fails, there are parameters that can be
adjusted to change the behavior of the automatic location scheme.

i. Click on the L ocate Point Settingsicon on the toolbar, or right-
click on the top or bottom image and select L ocate Point Settings
from the drop down menu.

Locate Point Settings x|

— Automatic Locate Point Settings

Detect: & Black Pointg  © white Paints

Intenzity Threzhold a0
kinimum Fixel Count 30
b aximum Pisel Count a000

M axirmum E coentricity 15

111

v Usze Image Settings

¥ Use Edge Detection

¥ Usze fwerage Background Femaoal
¥ Scale Down Large Size Images

k. I Drefault Cancel

There are different settings for the top and bottom images, so if
necessary, change both settings separately. For instance, if one
image is darker than normal, use alower Intensity Threshold value
for that image.

A useful tool for helping to know how to adjust the Locate Point
Settings is the Show L ocate Point Processing option availablein
the context menu of the image window. Right-click on the image
and select Show L ocate Point Processing.
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Calibration :: Untitled Calibration 10| x|
B HEHAE -~ BE* 5 ME|$ P

— Load Images

Load First Image |

Load Second Image |

 Lens Distortion and Fisture —

Lens 1 | I ~Mone -
Lom2| [ Fore -

Image Settings
Locate Point Settings Fisture | I - Mone -

Define World Reference Frame

Define Reference Markers — Paintz

Enable Midpoint Finder  Manual & Automatic

Show Locate Poink Pro Define First Region |

Enable Reticle
Enable Rulers

Shaw Paints Locate I Align |

[efine Second Reagion |

Shows Labels
Show Filenarne — Calibrate
Flip Horizontal Calibrate |
Flip Yertical

Wiew Calibration |
Wiew Actual )
Fit: in Window " Save Calibration |
Pan Made SetAs Default |
Zoom Mode

Draw Zoom Map

[ Graph Camera Locations
[™ ‘wodd Beference Frame

il. Inaddition, improving the contrast of the fixture points can also
help in automatically locating them. Y ou can change the image
settings for the top and bottom images by clicking on the Image
Settingsicon on the toolbar, or right-click on the image and select
I mage Settings from the drop down menu.

Image Settings

— B Image Settings

Reset
Brightness - | || L« I 0
Contrast | l L I u Load From File
G 1.0
amma l | L I Save TaFile
Exp./llog. - l L~ I u

1 e

Rewverze _|-d
Threshold [ | |/| 0

Digmizz

To locate points manually:
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Select Manual in the Points section of the right panel.

Click on apoint in the top image corresponding to afixture point.
Click on a point in the bottom image corresponding to the same fixture
point.

Click on the Add Point button.

If you wish to adjust the coordinates of a point, select the point in the
Pointslist. Click on the correct pointsin the top and bottom images.
Then click on the Update Point button.

= AT

To remove a point, select the points to remove in the Pointslist. Then
click on the Remove button.

After you have set al the fixture points, if you wish for them to be
automatically aligned to a standard grid pattern used by typical calibration
fixtures, then click on the Align button.

Note that since the screen reference markers are only visible in one of the
two cameras, the first sets of points will either have (-1,-1) asthe
coordinates for Image 1 or Image 2. Thisindicates that these points are
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only visible in one of the two cameras. Estimated XY Z values will not be
computed for these points.

6. Once al fixture points have been located, click on the Calibrate button.

X
\‘i.’) Zalibration Completed:
Mean Errar = 0, 7824 mnn
Std, Deviation = 00,3897 mm
Min Error = 0, 1308
Maz Errar = 1.7167 mm

If the calibration statistics are unsatisfactory, you must check your sources of error.
Check that al points have been located properly. Check that there is no unwanted
distortion introduced by the camera lenses, mirror, or other optics.

After apair of cameras have been calibrated, you can view the results of the calibration
by selecting View Calibration.
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x|
— First Camera — Second Camera
Location Location
| 537.4290 |2019.8799 [-1617.719 | 490.0275 |-2170.997 [-1616.022
Ratation Raotation
| 09338 00119 o012k | 09333 00142 [ 0.0011
| 00007 | 06983 | 07159 | 0mo7 | -0BM4 | 07195
| 0m73| 07158 | 0.6981 | 00094 | 07195 | 065
Transzlation Tranzlation
| -492.8738 | -251.9677 |2584.4433 | 461.0575 | -349.946 |2688.8313
Center of Projection Center of Projection
| 143064 | 1027.50 | 151993 | 102856
Auiz Scale Factors Az Scale Factors
| e57283| -BRE7EZ | E591.36 | -B570.45
— Calibration Statistics
tean Ermor Iw Standard D eviation m
Firirmurn E mor m M axiriurn Ermor |_1‘ﬁ
Urits: Millireters

After the cameras have been calibrated, for every point that you click on in the top image,
an epipolar line will be drawn in the bottom image and vice versa. The epipolar line
indicates which points in the bottom image could correspond with the point that you have
clicked on in the top image.

The current point in the top image is shown with ared plus symbol. The corresponding
epipolar line in the bottom image is shown as ared line. The current point in the bottom
image is shown with a blue plus symbol. The corresponding epipolar line in the top
image is shown with a blue line.

The red plus and the blue line and the blue plus and the red line may not exactly intersect.
The red and blue lines represent images of two rays coming from each camera. Since
they do not exactly cross, the midpoint of the shortest distance between the two linesis
shown with ayellow plus symbol in both the top and bottom views. The distance from
the yellow plus to the red and blue lines is the uncertainty in the position estimate.
Information along the bottom of each view indicates the 3D coordinates of the midpoint
and the uncertainty associated with the 3D coordinates.
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=10/ x|
ESELAE -~ BE* 40 e ME| &+ o

— Load Images

| Load First Image I

Load Second Image |

 Lens Distortion and Fisture —

Lo | [ Hore-
Lens 2 | I - Mone -
Fisture | I example.calb

— Paintz

" Manual % Automatic

XYZ = [1.221, 0.286, 469.749] 1 0.1140 millimeters = ;
Define First Begion |

[efine Second Reagion |

Locate Align |

— Calibrate

Calibrate

Save Calibration

Set Az Default

I
Wiew Calibration |
I
I

r r I Graph Camera Locations
XYZ = [1.221, 0.286, 469.749] + 0.1140 millimeters [ world Reference Frame

When you are satisfied with the calibration results, you can save the calibration to afile
using the Save Calibration button. Thiswill save all the calibration information to a
calibration file (*.calb) that can be used by the Measurement document to perform
measurements on other images taken by the same cameras.

If you would like the same calibration to be used for all newly created Measurement
documents, then select the Set As Default button after the calibration has been saved to a
file.

Fixture File Generation

Fixture files used by the calibration procedure must be generated after the wire frame has
been placed between each set of screensin the test range. The XY Z location of the four
reference markers on each of the screens and the four reference markers on the wire
frame fixture must be measured using a theodolite (or similar device). These XYZ
coordinates are in the local coordinate frame defined by the measuring device. All XYZ
coordinates must be in the same coordinate frame. Therefore, if using a theodolite, the
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theodolite must remain in the same position when conducting all measurements so that all
coordinates are in the same reference frame.

The input dialog for generating the fixture file for the Shadow Graph system is shown
below.

x|
— Screen Reference Markers [v2)
LeftScreen 1. [EIEE ~ [7687  [21667 Right Sereen 1.|-3442  [9117  [21648
2|nezs |77 21828 2 1836|9057 21828
303219 |16594 12809 3.|-346 [1792.3  [128001
4.|11956  |16568 12807 4.|1155 [1788.8  [127R.2

—ire Frame Grd [=vZ] [Left Side]

Markers  1.[28 1.7 {11885 Fows |3 Columns |4
2|azs o {11885 X 0Offset [0 Y Offset  [1635
<A [i [ [ ¥ Spacing [300 Y Spacing |300

4. IEH:":I'3 ID ID ™ From File I Browse,..

—fire Frame Grid (=72 [Right Side]

Markers 1|3 {1358  |1057 Rows |3 Columns |4
2|a0zs 1363 [10575 W 0Offset |0 Y Difset |17
323 [1365 |4 ¥ Spacing [300 ' Spacing {300

4.[a02.5 {137.2 [-3.7 [~ Fiom Fie | Browse...

Save Entries | Load Entries | |riitz: IMiIIimeters vI Generate Fisture Filz | Cloze |

LT IR

The XY Z coordinates for four points on each of the screens and four points on the wire
frame are required to generate the fixture file. The ordering of the four pointsis shown
below, as seen when looking down the flight path towards the back wall of the bunker.
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Shot Direction

Left Screen

R
—

M"
— i

4 |4
Yol e
3 3

Wire Frames

Note that the first point is always the point closest to the entry point and farthest from the
target.

In addition to the four target points on each of the two wire frames (shown in red),
additional offset and spacing information is required for each wire frame in order to
determine the location of the wire markers relative to the corner targets.

If you are standing underneath the right screen, looking at the wire frame, the wire frame
should appear as shown below.
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Wire Frame
8
* 2
| | | ] | | | ]
Q T | N | | E
L&)
o
o1
)
- N | [ ] [ |
B [ | [ | [ | N
N
O
> b |3 4y
P 5
X Offset X Space

Since the wire frame should be exactly planar, we only need to determinethe X and Y
coordinates of each of the beads in each wire frame. The X and Y offset of the first wire
bead from reference marker 3 alows us to compute the exact location of the first wire
bead. Each of the wires should be equally spaced apart, and each of the beads on the
wires should be equally spaced apart, creating a precise grid. Knowing the X and Y
spacing will allow usto compute the location of every wire bead in the frame.

If the beads on the wire frame are not equally spaced, then the exact X and Y coordinates
of each of the beads relative to reference marker 3 can be loaded from afile. Thefirst
line of the text file should specify the number of points that are contained in the file. The
subsequent lines should contain the X and Y offsets from reference marker 3, separated
by acomma. Z values are not required because the wire frame should be planar. To load
offsets from afile, check the From File checkbox and select the file to use by clicking on
the Browse... button.

Enter the correct values for both the left and right wire frames.
When all the values are input into the Fixture File Generator dialog, you can hit the

Generate Fixture File button and save the resulting fixture file.
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32

% cartesian points

% right screen

-344.2, -911.7, 2164.8
1189.6, -905.7, 2162.8

-346, -1792.3, 1280.1

1155, -1788.8, 1276.2

% | eft screen

-313.9, 768.7, 2166.7

1182.8, 771.7, 2162.8

-321.9, 1659.4, 1280.9
1195.6, 1656.8, 1280.7
%wre frame (left)

1.81287, 1.10067, 769.497
301.812, 0.734126, 769.498
601. 812, 0.367644, 769.498
901. 811, 0.00122332, 769.498
1.1061, 0.671558, 469.498
301.106, 0.447917, 469.498
601. 105, 0.224313, 469. 499
901. 105, 0.000746391, 469.499
0. 399325, 0.242448, 169. 499
300. 399, 0.161708, 169.499
600. 399, 0.080982, 169.5

900. 399, 0.000269464, 169.5
%wre frame (right)

2.81296, -135.987, 773.5

302. 813, -136.318, 773.6

602. 812, -136.649, 773.7
902.812, -136.98, 773.8
2. 61503, -136.185, 473.
302. 615, -136.478, 473.
602. 615, -136.771, 473.
902. 614, -137.065, 473.
2.41711, -136.383, 173.
302. 417, -136.638, 173.
602. 417, -136.894, 173.
902. 417, -137.15, 173.8

~NO 0100~ O O

The fixture file can then be loaded into a new Calibration document.
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£ rmaametersy

World Reference Frame

The coordinate frame of the calibration is the coordinate frame that is used by the
calibration fixture file that was loaded. All the coordinatesin the fixture file are
referenced from the local origin for a particular station. In order to compare information
from one pair of cameras to another pair of cameras or X-Ray systems, the coordinates
need to be referenced to some mutual world reference frame. All coordinates can then be
transformed from the local calibration fixture reference frame to the world reference
frame.
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A tool is provided to help define the transformation between the calibration fixture and
world reference frame. You

can access this tool by x|
selecting the Define World —Rotation and Translation [Hw=R "o+ Tw]———————
Refer ence Frame button on Fiotation [R]
the toolbar, or by right 1 |0 |o
clicking in the image and i 1 [o
selecting Define World [0 [0 [
Reference Frame. , :
Translation [Tw] [tz
There are three methods for o jo |0 Undefined ~]
entering information about the
world reference frame. You Diirect Entry i Twa Paintz on Z-Axiz I Diztances to Fiked Points I

can directly typein the

rotation and translation matrix — kM anual Entry of Fatation and Tranzlation

used to transform calibration Rl

coordinates to world 1 |0 o

coordinates. Or you can |0 |1 |o

select two points that lie on |0 i |1

th? WO:;d ref(—"ire?ﬁe;rame Z- Translation [Tw] Lritz

axis and supply the . —
coordinate of the first point o o o Undefined 7|
and the base angle of the

fixture. Or you can specify

the distances and coordinates

to a set of fixed points from
the origin of the local
coordinate frame.

Cancel Apply

Direct Entry

For the first method, if the rotation matrix and trandation vector are known, simply enter
them into the appropriate boxes and hit Apply or OK.

Two Points on Z-Axis

For the second method, the standard calibration fixture should be equipped with two
adjustable irises, one on each side of the fixture. If the fixture does not have these irises,
then you must use one of the other methods for determining the transformation to the
world reference frame.

The calibration fixture should have been positioned so that the irises are aligned with the
flight path and are visible in both camera views. To define the world reference frame:
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1. The system should have been calibrated already, as described earlier.

2. Click on the center of theleft irisin the top and bottom views of the calibration
document window. Check the uncertainty in the coordinates to make sure that a
suitable point has been chosen.

3. Click on Get Current for the First Point in the Define World Reference Frame
dialog. An orange box should appear in the calibration document window to
indicate the first point.

4. Click on the center of theright irisin the top and bottom views of the calibration
document window. Check the uncertainty in the coordinates to make sure that a
suitable point has been chosen.

5. Click on Get Current for the Second Point in the Define World Reference
Frame dialog. An orange box should appear in the calibration document window
to indicate the second point and a dotted line should be drawn between the first
and second points.

6. Enter inthe Z Coordinate of the First Point and the units of the Z coordinate.
This should have been measured when the calibration fixtures were being aligned.

7. Enter inthe Base Angle in degrees. This should have been measured when the
calibration fixtures were being aligned.

8. Hit Apply and the equivalent rotation and translation will be computed and

applied.
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Note that the first point should be the point closest to the entry point of the projectile. In
the

Distances to Fixed Points

The rotation and trand ation from the local coordinate frame to the world reference frame
can be determined by knowing

the XY Z coordinates of two Ditect Entry | Two Paints on Z+4wis  Distances to Fised Poirts |
fixed points combined with the . : _
dist toatl W0 oth — Distances to Fised Points
Istances to at feast two other 1V [ezrat |3 [103345 LoadDistances|
fixed points. —— :
2l s I i Load Wworld
The distances are used to al- |1 5.9a41 |-1 |-1 Ijlfi:-:Eﬁ_F'I:Iir'||:
. . aordinates
determine the translation. The 4fv [5.883 |3 37477
XYZ coordinates are used to 5 110675 | B Check box to enter
determine the rotation. ; : w2 coordinates.
6 IH'EHH I ! I ! ou must check,
Th di f th 7l IE?.EIEIEI'I |-1 |-1 at least two points.
he exact coordinates of the gl |2a1867 | B Units
fixed pointsin the world
[ [28.2753 |1 [ Meters ¥
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reference frame must be known. These coordinates should be placed into atext file. The
first line of the text file should indicate the number of fixed points. Each subsequent line
should contain the XY Z coordinates separated by commas for each of the fixed points.
To load the file containing the fixed point coordinates, click on the Load World Fixed
Point Coordinates button. Shown below is an example with five fixed point
coordinates.

5

890.7, 3681.9, -2177.4
328.3, -3544.6, -1927.6
16203.1, 3734.9, -1378.4
16221.9, 3731.1, -2191.9
15598. 3, -3493.4, -1428.7

For each of the fixed points, you must either enter a distance or XY Z coordinates. To
enter XY Z coordinates, check the checkbox next to the appropriate fixed point number.

Y ou must check at least two points. These values can also be loaded from atext file.
Thefirst line of the text file should indicate how many distances or XY Z coordinates are
contained in the file. For each subsequent line, if thereisonly asingle value, it isread as
adistance, if there are three values separated by commeas, they are read asthe XYZ
coordinates. To load values from afile, click on the Load Distances button.

A sample layout of bunker fixed pointsis shown below. The theodolite is used to
measure the XY Z coordinates to at least two of the points (typically the closest points)
and the distances to the remaining points.

bunker markers
{(known locations)

screens

theodolite

When you have entered all the distances and coordinates and have loaded the fixed points
coordinates file, click on Apply to compute the rotation and translation.

Page 24 of 38



User Manual
Professional Analyst, Flight Path Shadow Graph Edition

Using the World Reference Frame

Once the world reference frame has been defined, the coordinates of all points can be
displayed in either the local calibration reference frame or the world reference frame.

Y ou can select which frame to display in by checking the World Reference Frame
checkbox in the side control panel. When displaying coordinates in the world reference
frame, the graphs will label the axes as Xw, Yw, and Zw.

The world reference frame must be defined for each calibration if you want to compare
the measurements from one camera pair to another camera pair. For example, the Event
Summary document, that is described later, compares the results from multiple
measurement documents to compute velocity and angular velocity. In order to compare
these results, al the coordinates must be transformed into the same reference frame (the
world reference frame).

Reference Markers

In order to approximately compensate for small camera motions between calibration and
measurement, reference markers can be placed in the field of view of both cameras. This
isnot required. Only use this technique if you find that your cameras have moved since
the last calibration and you are unable to re-calibrate. This technique is only approximate
and it is highly recommended that you re-calibrate if possible.

There should be reference marks located in al four corners of each cameraimage. The
compensation algorithm will compute the necessary transformation to ensure that the
reference marks in the measurement images exactly overlap the reference marks in the
calibration images.

Y ou must identify and store the location of each of the reference marks for each
calibration. Click on the Define Reference M ar ker s button on the toolbar. Click on
each of the reference markersin the first and second image and click on the appropriate
Get Current button for each mark.
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After al eight reference markers have been located, hit Apply. The location of these
markers will be saved with the calibration information when the calibration is saved.
These values will be using during measurement to try to compensate for any movement
of the cameras between shots.

Measurement

After acalibration has been completed and a test has been conducted. The resulting
images from the test can be used to perform measurements.

A Measurement Document is created by selecting File > New. Then select
M easur ement.
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Change Calibration |
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— Paintz

Add Pairt |

Update Point |

Remave Paint |
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Save Measurements |
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[~ Graph Camera Locations
= Wioild Beference Frame

¥ Measurement Line Pairs

All the controls are located on the toolbar or on the panel on the right. The toolbar
controls were described earlier in this document.

A pair of images from an actua test should be loaded into the Measurement document.
An image from the top camera should be loaded using the Load First Image button. An
image from the side camera should be loaded using the L oad Second I mage button.

To perform measurements, a calibration must have already been performed for the
cameras being used. If adefault calibration had been set, the default calibration is
automatically loaded. If adefault has not been set, then a calibration must be loaded by
using the Change Calibration button.

When a calibration is loaded, any lens distortion information is also automatically loaded
and applied. See the Appendix for more information on lens distortion correction.

The units of measure and the world reference frame transformation are also loaded from
the calibration file. The units of measure that are displayed can be changed by changing
the units in the panel on the right. The world reference frame transformation can be
viewed or modified using the toolbar button or the right-click context menu.
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If you would like to review the calibration information, select the View Calibration

button.

After loading the calibration, if you are using the reference marker correction scheme,
you must locate the reference markers. If the cameras have not moved since you have
calibrated, then you should not have to use the reference marker correction scheme and

you can skip this step.

To define the reference markers, click on the Define Refer ence M arker s button on the
toolbar. Locate each of the reference markers and click on the Get Current button for

each marker.
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After al reference markers have been located, click on Apply. Each image will then be
transformed so that the reference marks in the measurement images (blue) exactly
overlap the location of the marks in the calibration images (purple).

M easurements can either be the 3D location of a single point, or the 3D locations of the
end pointsof aLine Pair. A linepair isagrouping of two sequential measurement points
(pointsland 2,3and 4,5and 6, ...).

Each Measurement document can display information as single point measurements or as
line pairs. To change the display, click on M easurement Line Pair s checkbox in the
right hand panel. When the Measurement document is set to show information asline
pairs, additional orientation and length information is computed for each line pair and
displayed in the Points listing. In addition, the first point in aline pair is shown in green
and the second point in aline pair is shown in magenta. The connecting line is shown in
cyan.

Typical stepsto perform a measurement:
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1. Click on afeature point in the top image. Zoom in using the mouse whesl to
accurately select afeature point. The mouse wheel will zoom in/out on the
currently selected point. It isaways agood ideato zoom in on afeature point to
ensure that you have selected the proper point.

2. Click on the corresponding feature point in the bottom image. Zoom in using the
mouse Whesl to accurately select afeature point. Verify that the uncertainty in
the resulting image coordinates is acceptable. The uncertainty is shown on the
bottom of each view. Thered, blue, and yellow points and lines should be near
one another in both images.

3. If you are satisfied with the feature points and uncertainty, click on Add Point.

4. 1f you would like to update the coordinates of a point, select the point in the
Pointslist. Click on the correct feature point in the top and bottom image, then
click Update Point.

5. Toremove apoint, select the point in the Points list and then click on Remove
Point.
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When you have selected all the points of interest, you can save your measurement results
to afile. Thiswill save the calibration information and measurement information to a
measurement file (*.meas).
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Note that the measurement file contains a copy of the calibration information. Onceit is
saved to the measurement file, the measurement does not use the original calibration file.
If you make any changes to the original calibration file, you must reload the calibration
into the measurement document using the Change Calibration button in order to apply
the changes.

Y ou can also export the measurement results to a Text document or to an Excel
spreadsheet. First select the units and the export format and then hit the Export Results
button. Hereisasample of the export resultsin Excel format. The sections are color
coded to correspond to the first and second points in the line pairs and the line
information for each pair.
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If the same calculations are always done in Excel, the export feature can aso be told to
use an existing Excdl file as atemplate for the export results. This template can contain
formulas, graphs, or any other Excel elements. Select Excel Template as the For mat
type before exporting. Then select the Excel file to use as atemplate.

Event Summary
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After you have created a set of Measurement documents for one event, you can combine
these all in one Event Summary Document. An Event Summary document loads a set of
M easurement documents and displays a summary of al the measurements contained in
each of the Measurement documents.

An Event Summary Document is created by selecting File > New. Then select Event
Summary.

7 Event Summary :: Untitled Summary ;iglgl
Time [zec]  File Mame
Measz 1 | | Load | Edit | Reload | Remove |
Meas 2 | | Load Edit Reload Remove
Meas 3 I | Load Edit Reload | Remave
Meas 4 | | Liad Edit Reload | Remaove
Meaz & | | Load E dit Reload Remove
Meas B I I Load Edit Reload | Remave
Meas 7 | | Load E dit Reload Remove
Meas B I | Load Edit Reload | Remave
Measz 3 | | Load Edit Reload Remove
Meas 10 | | Load E dit Reload Remove
Meas 11 I | Load Edit Reload | Remave
Meas 12 | | Load Edit Reload Remove
Meaz 13 | | Load Edit Reload Remaove
Meas 14 | | Load E dit Reload Remove
Meaz 15 I I Load Edit Reload | Remave
Meas 16 | | Load Edit Reload Remove
Center of Gravity, Diztance From Penetrator Tip IEI IEentimeters j |Ipdate |
Cizplay IFirst Fairt L‘ Units ILInu:Iefined "’I Foarrmat IE:-:::EI Blarik. Vl Expart |

L oad each measurement document by clicking on the corresponding L oad button. For
each measurement document, you must specify the time associated with that
measurement. This allows the application to compute velocity information between
measurements.

Up to sixteen (16) measurement documents can be combined into an event summary.
After you have loaded all the measurement documents, you can save the event summary
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information by clicking on the Save button. All the time and measurement document
information will be saved to an event summary file (*.esum).

If you wish to make changes to a measurement document, you can hit the Edit button
next to the measurement document file name. After you have finished making changes
and have saved the measurement document, you must hit the Reload button so that the
new changes are loaded by the event summary.

The Points listing will display information about each line pair contained in each
measurement document. Which quantity is displayed is controlled by the Display drop
down control in the Event Summary document window.

If you would like to display the coordinates for the center of gravity, you must supply the
distance from the projectile tip (first point of aline pair) to the center of gravity. If a
negative value is entered, the distance is measured from the projectile tail (second point
of aline pair).

Hes 14|
Ill-15|
Fiss 15 [

Livet ol Gty Dinbaron Fror Poratmion T [0

Tl mue [P =} g [Urdeleed =] o {Eecibird =] Gk

The Event Summary results can also be exported to a Text document or to an Excel
Spreadsheet.
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Select the units and the export format and then hit the Export button. Thiswill export all
available information about the measurement line pairs. The current display setting is not
used during export. All possible display values are exported simultaneously.
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If the same calculations are aways done in Excel, the export feature can aso be told to
use an existing Excdl file as atemplate for the export results. This template can contain
formulas, graphs, or any other Excel elements. Select Excel Template as the For mat
type before exporting. Then select the Excel file to use as atemplate.

All the information is exported into the template file in Excel, with any calculations or
graphs being automatically populated.
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Appendix

Lens Distortion Correction

A tool is provided to help compensate for radial lens distortion. Select Tools > Lens
Distortion Correction from the main menu..

For each lens that will be used, an image of a checkerboard pattern should be acquired.
This image can be loaded into the Lens Distortion Correction window to compute
whether or not distortion correction is necessary. The lens distortion correction tool will
compute coefficients to compensate for radial distortion (barrel or pincushion).

Lens Distortion Correction = |E||£|

— Compute Lens Distortion

Load Checker Image I

Define Reagion

Compute Distortion

Save Coefficients

— Comrect Lens Distortion

Load Image to Comect |

Load Coefficients

Correct Image

Ho image loaded. Save Comected Image

— Coefficients
= Center

¥ Center

—
—
R2Cosfficient |
—

R4 Coefficient

Update Coefficients

[ Show Comected Image

To compute lens distortion coefficients:

1. Capture an image of a checkerboard pattern using the camera and lens that will be
used in testing.
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2. Click on Load Checker Image and select the checkerboard image file (BMP,
TIFF, or JPEG).

i Lens Distortion Eorl_‘ection . 3 ;lglil
nerwfi i L .r:'.-l. S — Compuite Lens Distortion

Load Checker Image

Define Region

Compute Distartion

Save Coefficients

— Comrect Lens Distortion

Load Image to Comect |

Load Coefficients |

Carrect Image

Save Corected Image

— Coefficients

¥ Center I_
' Center I_
A2 Cosfficient |

I_

R4 Coefficient

Update Coefficients

[ Show Comected Image

3. Click on Define Region and click the left mouse button and drag a rectangle
around the inside of the checker pattern. Make sure that the rectangle isinside the
last set of checkerboard squares. Do not draw the region outside the entire
checkerboard pattern, it must be inside the checkerboard pattern.

4. 1f you would like to redraw the region, click on Define Region again and redraw
the rectangle.

5. Click on Compute Distortion. The distortion coefficientswill be computed. If
you wish to view the corrected image, you can hit the Correct | mage button.

6. Click on Save Coefficients to save the distortion coefficients to a lens coefficients
file (*.lens) that can be used by Calibration Documents.
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Lens Distortion Correction . = |D|ﬂ

e

— Compute Lens Distortion

Load Checker Image

Define Region

Compute Distartion

Save Coefficients

— Comrect Lens Distortion

Load Image to Comect |

Load Coefficients

| Carrect Image I

Save Corected Image

— Coefficients

# Center W
' Center IW
A2 Casflicient [76.5614
R4 Cosfficient [0.023378°

Update Coefficients

v Show Comected Image

The Correct Lens Distortion options are provided only for verification of removal of
distortion and as a tool for recovering undistorted images. These options can be used to
correct other images and save the corrected versions if desired. Thisis not necessary
since the application will automatically correct images on-the-fly if lens distortion
coefficients are set.

Do not use corrected images for measurement if the lens distortion coefficients are aso
specified. Thiswill result in the correction being applied twice and the resulting
measurements will be distorted.

If you wish to correct an image:

1. Load the image to correct by clicking on Load Imageto Correct.

2. Load lens distortion coefficients to use in correction. These should have been
saved using the Compute L ens Distortion buttons to create alens coefficient file
(*.lens).

3. Click on Correct Image.

4. You can switch between viewing the original and corrected image by clicking on
the Show Corrected | mage checkbox at the bottom of the control panel.
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5. If you wish to save the corrected image, click on Save Corrected Image. Itis
recommended that you save to a different filename so that you do not overwrite
the original image.
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